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Write Protecting Disks 
You can write protect a disk to protect it from ha\'ing data accidentallv 
changed or destroyed. When a disk is write protected, vou canno't 
save interior designs or any other kind of data on it. However, you 
can load designs from it. or copy files on it to another disk. Before 
you use the Interiors program disk. write protect it. Read on through 
this section to find out how. 

If you look at a 3.5" disk from the back side, you'll see a write pro­
tect tab located near the top left corner. To write protect a disk. use 
a pencil or appropriate item to slide the tab upward so that the small 
hole under the tab is uncovered. You can slide the tab back down 
again to cover the hole if you want to save anything on the disk at 
a later time. 

You can use this technique to protect final data disks as well. 
Remember though, the disk cannot have information written to it 
until the write protect has been disable (i.e. you slide the tab to cover 
the hole). An error message is shown if you try to save anything on 
a disk that is write protected. so don't write protect a working data 
disk that you'lI need to save your designs on. Write protecting a disk 
does not protect it against physical damage, like spilling a liquid on 
it. for example, so you should keep backup copies of your designs 
on other disks as well. 

Starting The Finder 
The Finder program is provided with Interiors on your program disk. 
Among other things. the Finder lets you start Interiors. make backups, 
initialize data disks, and copy disks or files. 

The first step to starting Interiors is to start the Finder. To do so. 
insert the Interiors program disk into your drive. turn off your com­
puter (if it is on). wait for about 30 seconds, and turn it back on again. 
After a short time. the Finder screen appears. 

I l't Fil. Edit VIfW SD'eIOl CQI., 
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After the Finder starts. a window with the name DYOH.INTERIORS 
at the top of it opens automatically (see the previous illustration). If 
for some reason the window does not appear, you can open it yourself. 
To do so, use the mouse to move the arrow pointer onto the disk 
(or volume) icon that has the name DYOH.INTERIORS beneath it. 
then double-click the mouse button. 

The Interiors application icon is inside the DYOH.INTERIORS win­
dow (if you had to open the window yourself. you may need to use 
the window's scroll bars to find the icon). It looks like the side view 
of a room with furniture inside it and has the name INTERIORS 
beneath it. IiIIi·:;; :;;:.":" 

M 
INTERIORS 

Room designs you have created and saved to disk appear with a docu­
ment icon when viewed from the Finder screen. The Interiors docu­
ment icon looks like this: 

I·w~ 
MY.HOME 

Note: The Finder will do much more than is covered in this user's 
guide. Please refer to your Apple IIGS System Disk User's Guide for 
detailed information about the Finder. 

Making A Backup 
Before you use Interiors for the first time. read this section and make 
a backup copy of your original Interiors disk. Then put your original 
disk in a safe place and use the backup for everyday use. If you damage 
your backup, you can make another one from the original. 

This section describes how to use the Finder to make a backup. If 
you haven't started the Finder, refer to the previous section and do 
so before continuing. then work through the following steps to make 
a backup copy of Interiors. 
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1. If you have one drive. remove the Interiors program disk from your 
drive and insert a blank disk. For two drives, insert the blank 'disk 
into the second drive. 

2. If the disk has never been used, you'lI see a message asking if you 
want to initialize it. otherwise, the disk's icon and name will ap­
pear on the desktop. Skip to 3 in that case. For an unused disk. 
click Initialize to continue. When asked for a name. type 
DYOH.INTERIORS2 and click Ok. Next, click ProDOS and 
800k 2: 1 to highlight the operating and disk size vou need. Then 
click Initialize to start the initialization. . 

3. Once the initialization has completed, move the pointer onto the 
original Interiors disk icon, press and hold the mouse button, and 
drag the icon' s outline onto the backup disk icon. Release the but­
ton. Read the confirmation message and click Ok. You'lI see 
messages instructing you to exchange disks as needed if you haw 
one drive. . 

4. When the copy process finishes. drag your original disk icon to 
the trash can (that's on the screen, not in your kitchen) and remove 
the disk from the drive. 

5. Double-click on the name below the icon of your backup disk­
on the name. not the icon. The name is DYOH.lNTERIORS2 
if you did step 2 above using a blank disk. A box will appear around 
the name so you can type and change it. Change the disk's name 
to DYOH.INTERI{)RS and press return. Your backup copy is 
now ready to use (it doesn't hurt to write protect it like you did 
your original disk). 

Now that you've made a backup copy of your original program disk. 
it's a good idea to make a backup copy of the Interiors data disk you 
received also. Follow the same procedure as described above to make 
a backup copy of the data disk. However, use the data disk's name 
and not the Interiors program disk name when you work throll~h 
the above steps. 

You should also create an additional data disk to store designs you 
want to save. To do so, insert a blank disk and click Initialize as 
described in step 2 above. Use an appropriate name for your data 
disk, INTERIORS.DAT A for example. Continue a<; described ahow' 
to initialize your data disk. Once initialized, it's ready for use. Pleasl' 
refer to your Apple IIGS System Disk User's Guide for additional help 
in initializing and duplicating disks. 

Remember, backup copies are only for your own safe keeping. It i~ 
not legal to distribute copies of this or any other software without 
written permission from the publisher. 
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Starting Interiors 
If you haven't started the Finder or made a backup. then you need 
to work through the preceding sections beginning with the "Cetting 
Ready" section before continuing. 

Next. make sure the caps Jock key is NOT pressed. This key has a 
special function within Interiors. It's explaineu a little later. 

To start Interiors from the Finder screen. inselt your hackup copy 
of the Interiors program disk into your disk drive. Then move the 
pointer unto the Interiors application icon and double-click. The ap­
plication icon has the name INTERIORS beneath it. If you have 
trouble finding it. see the "Starting The Finuer" section. 

You can also start Interiors from the Finder and have a design that 
you are working on automatically load for you. To do so, simply uouble­
click on the document icon above the name of the design that you 
want Interiors to open. Once Interiors loads and start<;, it will 
automatically open the design. See the 'Starting The Finder" sec­
tion for an illustration of the Interiors document icon. 

Important: Read this ii you started your computer from a uisk other 
than the Interiors program disk. Interiors requires the 4.0 version 
of the system disk. or a later version. This is the true 1 ti hit CS 
Operating System (CSOS) and the iirst operating system that shows 
the Welcome to the IIGS screen as the Finder IUilus. If you start 
the Finder from a ROM disk. Hard Disk. or at1\' disk other than the 
original Interiors program disk you received (or'backup of it), be cer­
tain you are using GSOS before launching Interiors or it will 
not operate properly. 

When Interiors starts, the screen looks like this: 
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The Interiors Desktop 
You can arrange the whole desktop to suit your own needs. All the 
windows are movable. To move a window. move the Dointer onto its 
frame or background area, press and hold the mouse 'button to make 
an outline of the window appear, then drag the outline to a new loca­
tion. Release the button and the window moves to the new position. 
The document window has precedence over other ,"indows. If a win­
dow overlaps the document window, part or all of the overlapping 
window may disappear beneath the document window. You may need 
to move or re-size the document window to get to a hidden window. 

As indicated above, you can change the size of the document win­
dow. Refer to the previous illustration. At the upper right corner, 
there is a small box called the zoom box. Move onto it and click to 
instantly enlarge the document window to fill most of the screen. A 
second click restores the original window size. Use the box at the 
lower right corner, referred to as a size box, to expand or shrink 
the document window to any size you want. To change the size, press 
and hold the mouse button. then drag the window outline inward or 
outward to the size you want and release the button. 

The box at the upper left corner is called a close box and is describ­
ed later. Don't use it yet. 

Quitting Interiors 
When you want to quit Interiors, first save your drawing to disk (if 
you want a permanent copy), then select Quit from the File menu. 
After Interiors quits. the Finder will start again. See the "Menus" 
chapter for more about how to save your designs. 

Making Interior Designs 
Information in this section is provided in a general context only. Read 
this section to gain insight into the overall design creation process, 
then work through the "Trying Out Interiors" section for a hands­
on introduction to using Interiors. 

The first thing you need to do to make an interior design is to creall' 
a room. However. when Interiors first starts, a default room is created 
for you. You can use it to become familiar with Interiors and refn 
to the "Creating A New Room" section for detailed information about 
creating your own rooms when you are ready. The default room is 
a top view of a rectangular room consisting of four walls. You call 
see it in the document window of the previous screen illustration (or 
on the screen). 

Next you'll want to place doors, windows, and other furniture intI' 
your room. The next section, ''Trying Out Interiors", shows how caS\' 
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it is to place furniture into the default room. Normally, you'll place 
and arrange furniture while viewing a room from the top. Then when 
the top view is the way you want. you can change to side views (you'll 
see more about this later). 

Finally, you can do customizing or add finishing touches to your in­
terior design. For example, you may want to change furniture's col­
ors, textures, or size. You can use the finishing tools (also explained 
later) to customize the top or side views of your design. 

Important: Customizing with the finishing tools should be the last 
step in creating a design since it's not possible to transfer finishing 
tool customization to a top or side view. Additionally, the top view 
of your design is the master view. All conversions to side views are 
generated from the top view, so if you make changes to a side view, 
they are not carried over to another side view or to the top view. You'll 
see a message asking if you want to save changes to disk before a 
view change is performed (i.e. when changes have been made using 
the finishing tools, or when changes have been made to a side view). 
You should save the changes at this time if you want to keep them. 
they are discarded if you click No. 

Trying Out Interiors 
For an introduction to many of Interiors features, read through and 
perform the following HANDS-ON exercises. Please refer to the 
previous screen illustration as needed throughout the first part of this 
section. 

Placing Furniture 
If you read the previous section, you'll remember that when Interiors 
first begins, a top view of a rectangular room is created for you. For 
now let's use the default room and experiment with adding furniture 
to it, but before continuing, get the command card that came with 
Interiors and keep it handy as a reference. You'll see more about it 
later. 

The quickest way to add furniture to your design is to press the let­
ter that corresponds to the piece of furniture you want. For example. 
go ahead and press the letter A to add an armchair to your room 
(see your command card). The four squares at each corner of the 
armchair are called handles. They indicate an object is selected. When 
an object is selected, you can perform some operation on it, possibly 
from the Edit or Adjust menus. This is explained in more detail later. 

Now that you have added an armchair to your room, you can move 
it to the location you want. Try moving it near (but not on) the top 
wall. To do so, use the mouse to move the arrow pointer onto any 
part of the armchair, then press and hold down the mouse button. 

1') 
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Notice a dotted box appears around the chair. Move the mouse to 
position the dotted box slightly below the top wall and release the 
mouse button. When you release the button, the chair moves to the 
new location. 

Now let's place a framed picture on the left wall of the room. First. 
press the letter P. Now, from the Adjust menu, select the Rotate 
Left item. This changes the picture's orientation so its front faces 
to the right, which is what we need for placing it on the left wall. 

You should note that when furniture is first placed in a room, the 
front of the furniture is facing down. This is important to remember 
when placing furniture so it will have the proper orientation when 
you change to a side view of the room. For example, if you look at 
your room from the right side. you want to see the front of the pic­
ture, not the back or side of it. Position the tip of the arrow pointer 
onto the picture (between the handles-not on a handle), then press 
the button and move the picture to any location you want along the 
top of the left wall. Put the picture's outline directly on top of the 
wall and release the button. 

Note: If you see a message saying that you can use handles to change 
object sizes when using the finishing tools (all explained later), it means 
you pressed the button on one of the picture's handles instead of be­
tween the handles. Simply click Ok and try again. 

Next, we'll add a microwave cart and a microwave oven to the room 
(these also double for a TV stand and TV). The microwave oven sits 
on top of the cart. First, press the letter N to place the cart. Leave 
the cart where it is. Now, hold down the option key and press the 
letter N again. Notice that a different piece of furniture is selected 
when you hold the option key down. This is also true with the shift 
key. By using option and shift with letters, 52 additional furniture 
selections are possible. 

Look at the height window at the left side of the screen and notice 
under the letters Hgt at the top of the window that the microwave 
defaults to a height of 2'8" off the floor. This is the approximate 
height needed to make the microwave rest on top of the cart when 
you change to a side view (approximate because sometimes a little 
adjustment is needed after you change views). You can change the 
height of the microwave, or any furniture that is selected, with the 
scroll bar in the height window. For now, leave the microwave and 
cart as they are. 

Your command card lists all the pre-drawn furniture objects and what 
letter keys to press for a given object. With a little use, you'll quickly 
become familiar with the keys and can easily add furniture directly 
to your rooms, or if you prefer, you can also choose furniture from 
the Objects menu (the "Menus" section explains how). 
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Changing Room Views 
If you have not done so, work through the previous section, "Plac­
ing Furniture", before continuing. 

Now that vou have some furniture in the room, let's see how everything 
looks fro~ various side views. At the bottom of the height window 
on the left side of the screen, you'll see these icons for changing to 
a different view of your room: 

The box in the center represents the top view of your room and the 
triangular icons surrounding it, side views. So to see a side view of 
your room from the bottom (or south), go ahead and move the pointer 
onto the bottom triangular icon and click. In a few seconds, the room 
and furniture changes to the selected side view. You can add furniture 
to side views (and move it) in the same fashion as you did on your 
top view. However, the top view is the master view. All side views are 
generated from it, so if you want to keep changes to a particular side 
view, you need to save them to disk before changing to a different 
view. This let" you customize each view to suit your own needs. 

Now, vie¥.; your room from the left by clicking on the icon at the left 
side. Notice here that the picture you placed on the left wall does 
not appear in the view. Furniture placed on top of an outer wall doesn't 
appear when you view your room from the direction of that wall. That 
way, the back sides of furniture that is located on walls, such as win­
dows, curtains, etc., aren't stuck in the middle of your side view. This 
is important to remember. You shouldn't allow furniture such as chairs 
and sofas to overlap walls unless you don't want them to appear in 
a side view (when viewed from the direction of the outer wall they 
overlap). 

Next, move onto the icon on the right and click to view your room 
from the right side. Now you see the picture on the opposite wall as 
you should. 

Go ahead and experiment changing to other views if you want. You 
can click on the box in the center to change back to the top view 
of your room. Before beginning the next section, change to a south 
(bottom) view of your room again. 
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Setting Furniture's Height Above The Floor 
This section continues where the pre\'ious sections left off. If you have 
not done so, work through the pre\'ious sections before continuing, 

Did you notice that the microwave appears on top of the microwave 
cart in your side \'iews. Its default height above the floor is set so that 
it will. As with the microwave, all pre-drawn furniture that is above 
the floor is set to a default height off the floor wht:1 Interiors starl<;. 
You are not limited to the default height however, simply select a 
piece of furniture (click on it), then go to the height window and set 
il<; height as desired. 

To demonstrate this, mo\'e the pointer onto the microwave and click 
to select it. If it's selected, four handles should appear at its corners. 
Now, move the pointer onto the top arrow inside the height window. 
Press and hold down the mouse button and let the height increa<;e 
several inches (the exact amount doesn't matter), then release the 
button. Notice the microwave is moved higher from the floor as it 
is adjusted to the new height. You can set the height of any furniture 
in the same fashion. However, if you set the height while viewing your 
room from the top, the furniture won't change position. Instead, the 
new height is remembered and you'll see the effect it has when you 
change to a side \'iew. If you move furniture in a side view, Interiors 
assumes you are positioning it backward or forward in the room and 
not changing its height from the floor. 

If you want to, experiment more with using the scroll bar to adjust 
the microwave's height. The arrows adjust the height more slowly 
and the shaded area above or below the box between the arrows morc 
quickly, Or, you can move onto the scroll box between the arrows, 
hold the mouse button down, and drag the box upward or downward, 
then release the button to change the height. 

When ready, read on to see how you can customize interior designs 
with the finishing tools. 

Using The Finishing Tools 
This section assumes you have worked through the preceding sec­
tions beginning with "Placing Furniture". If you have not done so, 
you should work your way here through the preceding sections before 
continuing. 

The finishing tools let you customize furniture or add custom draw­
ing, colors, patterns, and text to your room design. The finishing tools 
include both drawing tools and color tools, To begin, select Use 
Finishing Tools from the Options menu. When asked if you want 
to sa\'e changes, click No since this is only an example room for try­
ing out Interiors. Note that even though we are currently working 

16 

with the bottom view (or south view) of a room, it's possible use the 
finishing tools with any view. Just change to the desired view before 
using the finishing tools. 

After you select Use Finishing Tools, the height window disappears 
and the finishing tools' windows appear. Here is how the screen looks: 
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Using The Selector Tool 
The Selector Tool lets you select objects and change them, or move 
them to a new location. You can select furniture objects or object<; 
you've drawn with the drawing tools (see the "Drawing Tools" chapter 
for more about them). For now, we'll leave the furniture objects alone 
and experiment with some of the finishing tools. 

Begin by referring to the preceding screen illustration and select the 
Rectangle Tool. To select it, move the pointer onto it and click. 

Move into some blank area out<;ide of your room, press and hold the 
mouse button, then move the mouse to create a rectangle. Do the 
same to create a second rectangle so you'll have two rectangular ob­
jects that look similar to these: 

Exact locations and sizes aren't important here, The rectangles will 
only be used to explore some of the finishing tools. Now choose the 
Selector Tool (click on it). Notice the last rectangle you drew has 
handles at each corner like your furniture did earlier. 

The handles indicate an object is selected. Later you'll see how you 
can use them to change objects' sizes. Don't click anywhere in the 
drawing area or you may unselect the rectangle and we need it selected 
for now. 

Move your pointer to the color palette and try clicking on various 
colors and patterns, Notice how the interior of the selected rectangle 
changes to the color or pattern you click on, It's that simple to ex­
periment with various color or pattern combinations in your room 
designs, whether it is with objecl'i you draw, like the rectangles, or 
existing furniture, like the armchair. Try holding the apple key down 
when you click on a color or pattern. It lets you change an object's 
border color or pattern. 

Now click on the transparent button (with the letters Trn) by the 
top right side of the colors to show only the object's border (i,e. make 
it transparent). Click on any color or pattern to make the object solid 
again. 
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You can change the border width just as easily by clicking on a dif­
ferent size in the line width window. Click on the widest line in the 
line width window. Notice that the size of the rectangle remains the 
same-only the width of its border changes. 

To see how objects are unselected, click on a blank. or unused. area 
inside the drawing window. The rectangle's handles disappear. Select 
it again by moving onto it and clicking. To select both rectangles at 
once (or multiple objects), hold the apple key down and click on the 
second rectangle. Now click on a color and notice both objects take 
on the color. Any change you make (by clicking on colors, changing 
line thickness, or whatever) affects ALL selected objects. 

You can also select multiple objects with a dotted box referred to 
as a selection bo.\:. To do so, move the pointer beyond the top left 
corner of the objects to be selected-the blank screen area outside 
of any object. or in this case. outside of the two rectangles. Hold the 
mouse button down and drag the resulting dotted box to the lower 
right corner of the objects to be selected. Release the button. All the 
objects that are within the selection box are selected and will ha\'e 
handles. Click on any blank area of the screen to unselect all selected 
objects. 

As you've already seen, you'll often need to move objects to another 
location. You can move one object or many objects at once. To move 
the two rectangles you drew, select them both as described above. 
Then move onto either rectangle. Press and hold the mouse button 
and move the dotted outline of the objects to a new location. Release 
the button. To move a single rectangle, first click on a blank area 
to unselect both rectangles, then move the pointer onto the rectangle, 
hold the button down and drag its dotted outline to a new position. 
Then release the button. 

Suppose you want to remove one or more objects from your design. 
That's easy. Just select the object(s) you want to delete, then press 
the delete key or choose Clear under the Edit menu. You can delete 
all objects by choosing Select All, then pressing delete or choosing 
Clear. Undo will restore deleted objects if you don't make any other 
changes before selecting it. 

You can perform many other operations on objects that are selected. 
They are described in detail in other sections of this user's guide, 
In genera\' you can use items in the Edit, Adjust, and Text menus 
on selected objects. 

Go ahead and experiment with changing furniture colors and using 
the finishing tools. When you are ready, read on to see how to create 
a new room and learn more about other Interiors features. 
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Creating ANew Room 
There are basically two kinds of rooms you can create. a square. 
rectangular-type room. or an irregularly-shaped custom room. To 
c:-eate a rectangular room. you need only to specify a room's dimen­
sions. To create a custom room. vou can draw the room's walls to 
your liking. . 

Whichever kind of room you want to create. you can begin one of 
several ways. You can go to the File menu and select New or Close. 
t lr you can click on the close box at the top left corner of the docu­
ment window. Once you've used any of these methods. you'll see the 
following dialog: 

Room Size----____________ ~ 

« 
( 

lolidth: l1EI ft [![J in 

OeDth: UI1 ft [][]in 

Hei9ht:[TIft [![]in 

Max Size: 32' x 22' x 10' 
Min Size: 4' x 4' x 4' 

Ok ( Cancel 

Ora\·, Custom Room 

) 
) 

Creating A Square Or Rectangular Room 
To create a square or rectangular room (after selecting New. Close, 
or clicking the close box), simply type the dimensions of the room. 
Cse the tab key to move from one dimension box to another for typ­
ing. or click on a box to move to it. You can use the arrow keys to 
move within the text inside a box and the delete key to remove text. 

Click Ok to erase your original room and furniture and draw a new 
room using the new dimensions. or click Cancel to retain your original 
room and furniture. 

Creating A Custom Room 
To create a custom room. sclect New or Close from the File menu. 
or click the close box. then click Draw Custom Room. The screen 
changes and looks like this: 

Click when done With room 

Selector Tool 

Lrne Tool •• i!~ni2J]l~"""'I[II~~ql~~~~~~ 

l\otice that vou now have two drawing tools below the menus ncar 
the left side'of the screen. the Selector Tool and a Line Tool. for 
drawing and editing room walls. The drawing window contains rulers 
and measurement-; so you can ea-;ily make the room any size you want. 
You can also usc some items from the Edit menu. such as Undo and 
Clear. to aid in drawing an outline of your room. 

The goal hen: is to draw an outline of your custom room by drawing 
the walls t( l the appropriate lengths. You do not need to he absolutely 
precise connecting the corners and making the walls straight. ~he 
program will automatically scan the walls and connect corners wh~ch 
you may not have exactly connected. It will straighten. walls whICh 
\'ou may have drawn slightly crooked. Larger gaps or dlagonal11l1es 
~re ass~med intentional and left as they are. The Selector Tool and 
the Line Tool work the same a" when using the finishing tools. See 
the "Trying Out Interiors" section and the next chapter. "Drawing 
Tools", for detailed information ahout them. 

In general. to draw a wall. click on the Line Tool. move to the draw­
ing area. press and hold down the mouse button. and move the mouse 
to drag a wall to the desired length and location. then release the 
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hutton. You can click the Selector Tool and lISe it tu move. kngthen 
or shorten. delete. or copy walls (lines). 

Once \'Ou\'C created an outline of \'Our room. click Ok to keep it. 
or click Cancel to exit and keep yo~r original room. After you click 
Ok. type the ceiling height you want for your custom room. Usc the 
tab and delete keys as needed and click Ok when the height is cor­
rect. :\'ow. all YOlll: original walls and iurniture arc ddeted and your 
new room is drawn and read\' for furniture. or ready to examine from 
side views. You can select Change Room from the Edit menu to 
change an existing room and keep existing furniture. 

Interiors is designed to work with a single room at a time and not 
an entire house or group of rooms. However. depending on your par­
ticular objecti\'e. vou rna\' he ahk to draw dividing walls or multipk 
rooms and get th~ desir~d result. You'll need to draw the walls and 
cYcle through the various views (after clicking Ok) to determine if 
the resull" arc satisfactory. As mentioned ahove. vou can usc Change 
Room to make modifications to existing walls. y'ou also have the op­
tion of deleting walls. adding walls. and doing other customizing using 
the finishing tools. In addition. there is room divider furniture which 
may he useful in some rooms (vou'll find these with the Other oh­
jects on your command card a'nd under the Objects menu). 

One more nOle ahout drawing custom rooms: whel'l Interiors starr". 
auto scrolling is enahled. That means when you draw a wall and go 
heyond the bottom or right side of the drawing window. your draw­
ing is automatically scrolled to make more space for you to draw. 
If you prefer. you can go to the Options menu and disable this feature 
before you hegin to draw a custom room. 

')') 

2-Drawing Tools 
You can usc the dr,l\\'ing tools to add custom drawing or text to your 
room design. They arc part of the finishing tools and ~ppe?r.1t1 ~w() 
windows at the kit side of the screen after you selcct Use Flnlshmg 
Tools irnm the Options menu. Howe\'er. one tool. the Selector Tool. 
is the actin' tool when vicwing your room from the tDP and S](j.l'~. 
It's used ior seil'cting. mo\'ing. and manipulating your tUr1:lturC. \ ou 
shouJd read tIll' "Sdector TooJ" section cven it \'(IU don t need tht: 
othlT tools right away. 

HlTe arc the drawing too1 windows: 

Selector 10 
Line 

Hollow Line 

Rectangle 

Rounded Rectangle 

Drawing 
Tools 
Window 

I 

Oval 
Arc 

Polygon 

Sketch 

Text 

View Change Icons 

Line Width Window1 

II\II!_III 

The large window contains tools which Jet you choosc the kind of 
ohject YOU want to draw. The smaller window lel" you choose the Width 
(,(Jjnc~ or ohjcct's horders. To make a tooJ activ\.', or select a Jllle 
width. move thl' pointer onto it and click. 



Line \Vidths 
A check mark indicates the current working line width. Lines and 
(Ihjecb' h()rders are drawn with the cum.'nt working width. If the Selec­
tor Tool is active. the line widths and border widths of selected oh­
jects are also changed when you click on a new width. 

Selector Tool 
The Selector Tool leb you choose ohjecl~ for moving. re-sizing. 
changing colors. border widths. or many other operations described 
lakr in till' "Menus" chapkr. Though the Selector Tool becomes 
visible a<; a tool only after selecting l'se Finishing Tools. it is in realitv 
the toni th:1t is active for selecting and placing furniture while vie\\:­
ing your room from the top and sides. so it's hest to read this section 
even if you don't have an immediate need for using the finishing tools. 
Also. work through the "Trying Out Interiors" section for a hands­
(In guide t() placing and moving fumiture. and using the Selector Tool. 

Selecting Objects 
When the Selector Tool is active. your pointer remains an arrow. 
e\'en when it is over the drawing windo\\'. The pointer's hot spot. 
the part that is used to determine what you haw selncted. is the tip 
of the arro\\'. 

To Sl'il'ct a larger solid object. movc the arrow onto it and click. When 
choosing a small object among closely-spaced objecl<; or lines. carefullv 
place the tip of the arrow exactly on the ohject you want to sele~t 
and click. If an object is transparent. place the tip of the arrow on 
the object's horder and click. 

F( lUI' small squares. called handles. appear at each corner of selected 
ohjecb (lines haw a handle at each end). If you are trying to select 
a small or transparent object and handles do not appear. re-position 
the tip of the arrow and try again. When selecting among closely­
spaced objecb. if handles appear on an object other than the one 
you want. click on a hlank area of the screen to clear the handles 
and try again. 

~ote: In some situations. handles can cancel each other uut. Handles 
are drawn by n.'\·ersing the colors on the screen under a given handle. 
That way they can efficiently and quickly be era<;ed by reversing the 
colors a second time rather than by erasing the handles and redraw­
ing the ohjects. The only drawback is that occasionally two handles 
may occupy precisely the same location. In this ca<;e. wh~n the second 
handk is drawn. it reverses the colors that were alread\' reversed from 
drawing the first handle. This has thc effect of era~i~g the first han-

die instead of drawing a second one. The object(s) are still selected. 
and treated as such. even though one or more handles may not ap­
pear. This happens infrequently and if you watch closely when it does. 
you'lI see the handles flash briefly on the screen indicating they are 
actually being drawn. 

Here are some examples of selected objects: 

·0· 
• • 

.~. 

~S. 

Y (JU can hold the apple key down and click on additional (lbjecl~ 
to make multiple selections. You can also select multiple ohjecl" with 
(\ dotted box referred to a<; (\ selection box. To do so. move the pointer 
to the top left side of the objects to be selected. Hold the mouse hut­
ton down and drag the resulting dotted box to the lower right corner 
of the objecl<; to be selected. Release the button. If any portion of 
an object falls within the selection rectangle. it is selected. Click on 
am blank area oi the screen to unselect all selected objects. or click 
on' an object without holding the apple key to select it and unsclect 
all others. 

Features that need at least one object selected in order to work will 
operate on all ohjecl<; that arc selected. For example. if two ohjects 
arc selected and you click on a color. both ohjects take on the color. 

In general. items from the Edit, Adjust. and Text menus operate 
on selected ohjecl". In fact. most items in these menus remain disabled 
(dimmed) and unusable until one or more objecL" have been selected. 
Each item is described fully in the Menus chapter. 

Moving Objects 
When the Selector Tool is active, you can move objecl~ hy drag­
ging them to a new location. To do so. move the pointer oyer an ob­
ject. then press and hold the mouse button. When a dotted outline 
of the object appears, move the outline to the new location of the 
object and release the button. 

You can move several objects at once by selecting all the objecl" you 
want to move. mO\'ing the pointer directly over anyone of them. and 
dragging the outline to a new location. All objects moved at the same 
time will remain in the same configuration relative to each other. 



Sizing Objects 
This ieatun.' applies I l!1lv after YI)U hare sekckd l'se Finishing Tools. 
You can changl' the size of furniture ohiects or all\" other kind oi oh-
Il'ct t Ik·n. '. 

To change the sizl' 0(:1 sL"il'ckd ohiL'd. mme the poinkr onto one 
I ,f iL~ handles. Press and hI )Id the ml 'lISl' hutton. \ \'hl'n a J( ,tted I )utline 
(,i tilL' "hil'ct appears. drag till' "hln"t to a new sl~e. For l'xample. 
to l'nlMge a rl'ctangle Jownward ;tIld to the right. use thl' kllldk on 
its hottom right corner and dr~lg d()\\"J1 and to thl' right to the desired 
size. 

I I 
'\. Drag 

Size an object hack dmm hy moving the dotted outline inward. Change 
the size in other directions hy dragging with a different handle. 

Sl,lect l'ndo at till' leit side of thL' colors window or IlndlT thL' Edit 
mU1lI to rewrSL' thl' bst changl' madl. l'ndo is descrihL'd fully in the 
"~knus" chapter. 

Line Tools 
The Line Tool and the Hollow Line Tool arc I'm drawing straight 
lines. As mentioned earlier. ~'ou can change the line width hy choos­
ing a new width irol11 the line width window below the tools. If the 
Selector Tool is acti\'L', the lillL' widths oi selected oh.iL'cb are changL'd 
also. 

TI I dr:lw lines, 111(1\'L' thL' poinkr tl' tilL' stalting point of thL' line. press 
and huld the mousL' hutton whik moying the mouse to drag thl' line 
t(, tlk' dL'sired l'nd point. then reLl~l' till' hutton. You can draw str;li~ht 
1i1lL'~ at pl'dect 4:=i or ~)() degrL'e an~les hy pressing the apple or shift 
kL'y hL'iore you hL'gin the linL'. 

To dnngl' thl' working color I',)r lineS nhe color uSl'd to dra\\' the 
line). hI ,ld down the apple h'y and click on the color or pattern you 
\\':lnt for the line. Do thl' s:lmc to ~L't thl' horder color for hoIlO\\·lines. 
Click un a color to select thL' interior color I'm hollow lines (normally 
\\·hitd This method of ~electing colors is used for other ohiecb as 

well (sec a complete explanation in the "Color Tools" chapter). Again. 
if the Selector Tool is active. the colors of selected objecb are also 
changed. 

Note: A hollow line does not become hollow unless the line size is 
at least 3 dob high and it is transparent. As indicated above. you 
can also fill hollow lines with patterns or colors. 

Rectangle, Rounded Rectangle, Oval, 
And Arc Tools 
As their names imply. you can use these tools to draw rectangles. 
rounded rectangles (rectangles with round corners). circles or ovals. 
and arcs. You can change their border widths by clicking a new size 
below the drawing tools. You can change their border and fill colors 
or patterns the same way as described for lines above (see "Color 
Tools" for more). 

To use these tools. place the pointer where you want one edge of 
the ohject to begin. Press and hold the mouse button. drag the ob­
ject to the size and orientation you want (you can drag any direction 
from the start point). then release the button. 

You can also make obiecb transparent (only their borders are drawn) 
by clicking on the tr~nsparent button with the letters Trn at the 
top right corner of the colors' window. Click on any color or pattern 
to make objects solid again, 

To draw arcs (you would normally draw these transparent - see above 
for how). drag downward to draw the top part of a circle. and upward 
to draw the bottom part. For example, you can create the following 
arc by dragging down and to the right. 

To draw perfect circles with the o\'al tool. squares with the rectangle 
tool. or 90 degree arcs with the arc tool. press the apple or shift 
key before you begin to draw. 



Polygon Tool 
Use this tool to create a polygon. or many-sided. object. To draw a 
polygon. moye the pointer to il<; start point and cli.::k. Move to the 
first line's end point (and next line's start) and click again. Continue 
this sequence until you 'ye completed the object by ending at your 
original start point. or double click anywhere to end and have the 
la<;t polygon line automatically completed for you. 

As with most other objecl<;. you can change a polygon's border width 
or make it transparent. 

The following are all examples oj polygons: 

Sketch Tool 
This is a flexihle drawing tool used to create irregularly-shaped ob­
jecl<; or regions. Here are some examples: 

To sketch. move the pointer to the start position. press and hold the 
mouse button. and move the mouse. Relea<;e the button to stop. 
Remember. this tool still creates an object entity so it's desirable to 
end the sketch where you begin (a<; with polygons). If you release the 
button elsewhere. the object is completed for you with a straight line 
back to the start. 

If you don't want a border on your sketched object (or any object). 
simply set the border color to the same color or pattern as the in­
terior color: by holding the apple key down and clicking on the col­
or or pattern you want for the border. 
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Keep in mind that a good deal oi memory is reLJuired to maintain 
a sketched ohject. All ib poinl<; must he remembered and redrawn 
when the object is moved. or if it needs to be rcdrawn for any re~"on. 
This can dr~<;tically slow the proccss of refreshing the drawing windo\\'. 

It is wise to use this tool only when really needed. and to use the other 
drawing tools instead whe~ they are appropriate. When you need to 
sketch. complete the bulk of your drawing first and draw the sketched 
area<; la<;t so vou aren't burdened with slow window refreshes for your 
entire drawi~g job. Also. the smaller the sketches. the better. If the 
Polygon Tool will work. use it. Though not a" fast as objecl<; like 
squares and circles. polygon objects still redraw much fa<;ter than 
sketched objecl<;. 

Text Tool 
Use this tool to add text or labels to your drawing. 1\10\'l.' the pointer 
to the spot you want to hegin typing and click the mouse button. You'll 
see a flashing har cursor appear. Go to the keyhoard and type your 
text. Press the delete key if YOU make a mistake. When YOU have 
finished typing. you can s'imph· select a different tooL Th~ text you 
typed will be convelted and kept as a single object. 

If you want to continue typing but in a different location. use the mouse 
to sekct the new location and click. The la<;t text you typed is kept 
as an ohject and you can begin typing a new kxt ohject as before. 

You can press the return key to end a line of text and start a ne\\' 
line helow the previous line .. 

Sekct Choose Font from the Text menu to set the size. style. or 
type of font you want for your text. You can make size. style. ~)r font 
changes to existing text by selecting it (with the Selector Tool). then 
using the Choose Font item and making the desired changes. See 
"Choose Font" in "Chapter 4" for a complete description. 

Change the color of text hy clicking on a color at any time while typ­
ing or hefore you hegin typing. and for existing text. change the col­
or hy selecting the text (with thl' Selector Tool) and clicking on a 
color. . 



3-Color Tools 
~he color to~ls are a\'aila~1e after you select Use Finishing Tools 
flom the Options menu. 1 hen. they appear near the bottom of the 
screen and look like this: 

Each item in the color tools window is descrihed in the following sec­
til illS. Plea"e refer back to this illustration as needed. 

Selecting Colors 
The curre.nt color (or pattern) selected for drawing is referred to as 
the workIng color. The currently selected working c"lor is shown 
at the left end of the color palette. 

To change the \\'orkini4 color. click on the desired palette color or 
pattern. If the Selector Tool is active. a click on a color will also 
chani4e the color of selected objecl<;. 

When. dr~wing occur~. un~~ss O?jecl<; are transparent. the working 
col.or IS used to fill ohJects mtenors. To change the border color of 
ohJect'i. press the apple key before you click on a color or pattern. 

The workin~ color is framed by the working border color in the box 
at the left Side of the color palette. The lines in the line width win­
dow are also drawn with the workinl-?: border color. 

Y nu can rr:ake the border color the same as the working color to create 
objects Without contra'iting borders. 

:1O 

Selecting Patterns 
Patterns are selected and used the same as any color. They can be 
used for object horders or fill colors. There are 48 patterns a\'ailabk 
at anyone time. and more can be created. saved to disk. and loaded 
as needed. See the "~knus" chapter to find out how. 

Sixteen patterns are shown in the color tools window. Click on the 
workini4 color box at the left side of the patterns to cycle throul-?:h 
the next six ken patterns. 

Undo Button 
Undo was placed in the color tools window for quick. easy access. 
This Vndo works in exactly the same way a<; the one under the Edit 
menu. Use it to re\'erse the la"t change made to colors or your draw­
ini4. In most instances you can click it again to re\'erse the Undo also. 
or toggle between the last chanl-?:e made and the state hefore the change 
W,L'i made. When Vndo is not available. it is dimmed. 

Note that all other buttons in the color tools window relate to colors 
only. 

Dupe, Swap, And Blend Buttons 
You can USl' thl' three buttons. Dupe. Swap. and Blend. in the col­
or tools window to change or arrange paIettl' colors. Click on a but­
ton to highlight it (lighten it'i color) and activatl' it for use. 

Note: The two colors on each end of the palette (black. dark gray. 
light i4ray. and white) are reserved to maintain the intel-?:rity of the 
screen display and windows. They are included in the palcttl' so you 
can use them in your drawing. 

Dupe 
Dupe (duplicate) lel'i you copy one palette color over another. To 
duplicatl' a color: click on Dupe. move the pointer onto the color 
you want to duplicate. press and hold down the mouse button. then 
slide the color's outline to the location where you want a duplicate 
and relca'ie the button. Object" on the screen which were the destina­
tion culm become the new culor. Click on Undo to reverse the chanl-?:e. 
You may duplicate one of the jour reserved end colors (see the ahove 
note) to another unreserved color location. but you may not move 
a color onto any of the four reserved end colors. 
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Swap 

rse Swap to exchange the position oi two colors without altering 
either color. Each color is moved to the other's position in the palette. 
This causes ohjecl" on the screen which are drawn with the colors 
to have their colors swapped also. 

To exchange colors: click on Swap. mow the pointer onto one oj 
the colors. press and hold the mouse hutton. thL'!) slide the color's 
outlinc o\'cr the color you want to exchange it with and release the 
mouse hutton. You can click on l'ndo to re\'(~rse the change. The 
iour reserwd end colors may not he in\'()l\'ed in a Swap. 

Blend 

Blend is a feature that lel" you create a series of intermediate colors 
between two target colors (how is explained a little later). All the col­
ors hetween two target colors gradually blend from the first target 
color into the second target color. For exampk. if you choose the 
dark gray on the left side of the palette as the first target color and 
the light gray on the right side as your sccond target color. all the 
palette colors hetween them will tUI1l to ~radient shades of gray. Again, 
the two reser\'ed colors on each end of the palette may not be changed 
h~' a hlend. although a blend may include dark or li~ht gray for a total 
of 14 squares that can be il1\'olved in a hlend. and 12 that can be 
chan~ed hy a hlend. 

You can use Dupe or Swap to position target colors in the palette 
hefore blending. For example. you might mo\'e red (with Dupe) next 
to the dark gra~' color and place white four squares to ib right, then 
hlend hehwen the two im \'arying shades of red. Then you mi~ht 
mo\'e green next to the last white target color. and put li~ht hlue 4 
squares to its right. then blend hetwel'n them creating 2 separate 
hlends in the palette. 

To get the maximum numher of intennediate colors irom Blend, use 
Dupe or Swap to move the target colors to each end oi thc 12 
changeahle color squares. Many more variations are possihle. Go 
ahead and experiment. You can always click Undo and reverse the 
la"t chan~e made. or restore the standard colors hy selecting Default 
Colors under the Options menu. Hemember that ohjecl" on the 
screen (and pattel1ls) that were any of the original colors will take 
on Blend changes also. 

To Blend: click on Blend. move onto either one of the two target 
colors that \'ou want to Blend between. press and hold the mouse 
hutton. sliJ~ the color's outline to the second target color. and release 
the hutton. Again. you can do repeated blending. and use Dupe or 
Swap to arrange the color palette as desired. 
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Changing Palette Colors Via Mix 
To change the amount oj Hed. Green. or Blue (HS~B) in a palette 
color. click on the Mix button at the right end 01 the color tools 
window. 

A window will appear with 3 scroll bars. Cli~k on one of the colors 
in the palette to choose a working color. ThIS workll1g color wIll he 
shown helow the scroll bars. Use the scroll bars to change the col­
or's RGB mix. or level. Each Red. Green. or Blue k\'el can range 
from 0 to 15 for a total of 4096 possible colors. ClIck on ~he scroll 
har arrows to change the mix slowly. As the chosen workll1g color 
changes. you'll see the same color on the palette change. and also 
al1\' ohject" on the screen that are the workll1g color wIll change. 

Y (;u can click on another palette color to make it the wor~ing color 
and change it. or when you're finished changll1g colors. clIck on the 
mix window's close box (or anywhere on the drawlI1g wlI1dow) to 
remo\'e the mix window, 

Making Objects Transparent 
The remaining color toollel;; you draw trans~are~t objecb. Tra,ns­
parent objects consist of borders without .any II1tenor fill color. '\ ou 
can see through transparent object'i-objects underneath them are 
visible. 

To draw transparent objects. move the pointer ontothe t~ansparent 
hutton at the right side of the color palette and ~lIck. 1 he button 
has the letters Trn on it. Now object., you draw wIll be transparent. 
Click on a pattern or color to draw solid object;; agam. 

').) 
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4-Menus 
This chapter describes the pull-down menus along the top of the 
screen. To pull a menu down. place the arrow pointer on top of its 
title. then press and hold the mouse button down. A list of menu 
choices will appear beneath the menu title. To select a menu item. 
continue to hold the mouse button down. then move the mouse 
downward. Menu choices are highlighted as the pointer passes over 
them. Release the mouse button to select the highlighted menu item. 
Menu items you cannot use at the moment are dim. If you select a 
dimmed item. a help message is shown informing you what is need­
ed for its use. 

You can select manv often-used menu items from the kevboard. Those 
items are indicated' with an apple symbol and a keybo~rd character. 
Here are some examples: 

• ~n... 
Undo'" OZ 
Cut oX 
Copy oC 
Paste OV 
Clear 
SelectRl1 oR 
Lock oL 
Unlock OU 
Group oG 
Ungroup oH 
Info 01 

To make a menu selection from the keyhoard. press the apple key 
along with the appropriate keyhoard character. In the ahove illustra­
tion. if you wanted to choose Select All. you would hold down the 
apple key and press the letter A. Keyboard selections are petiorm­
ed just as if you had pulled down the menu and made them with the 
mouse. You do not need to press the shift key if the character is on 
the upper part of a key. 

Apple Menu 
The Apple menu (it's an apple symbol at the upper I~ft corner) con­
tains an About item and the names of desk accessories you can use. 
These are explained next. 

About 
This choice shows information about Interiors such as the copyri~ht 
date. the company that published it. and the programmer's name. 

Desk Accessories 
Desk accessories are normally short programs you can choose that 
do some specific task (like a clock. calculator. simple game. or puzzle). 
A list of available desk accessories are added to the Apple menu. 
Choose them like any other menu item. 

The choices vou have depend on what desk ~Iccess()ries are in the 
SYSTEMIDESK.ACCS/ folder of the disk you used to stalt your 
computer . 

File Menu 
New 
Select New when you want to erase your current interior desi~n and 
create a new room. You are given the opportunity to save chan~es 
to your existing design (see Save below) or caned before you hegin 
creating a new room. Refer to the section "Creating A New Room" 
in the "Getting Started" chapter for details on creating the room. 

Open 
Open displays a catalog of the current drive and let'i you load an ex­
isting interior design. You are given the chance to save your current 
design if changes have been made (see Save). 

Note: If a design has text objects (from using the finishing tools), In­
teriors tries to use the same fonts they were originally created with. 
The same fonts must be available in the /SYSTEM/FONTS/ folder 
of vour startup disk so the Font Manager can load and install them. 
If the Font Manager cannot load the desired font. the nearest match­
ing font is used instead. 

Close 
Close lel'i you erase your current interior design and create a new 
room. Close and New are implemented identically by Interi()rs. Both 
are induded for completeness. As always. you'll have a chance to save 
your current design if changes have been made since the last time 
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you saved it. Refer to the section "Creating A :-.Jew Room" in the "Get­
ting Started" chapter ior details on creating a new room. 

You can also click the close box at the upper left corner of the docu­
ment window to pertorm a Close. 

To end your editing session. use Quit rather than Close. 

Save 
Choose Save to save a copy of your interior design to disk. If your 
design is untitled. a dialog appears so you can name it. You should 
give your interior design a unique name and not save it with Untitled 
as its name. 

If your design is already named because you have saved it during the 
current session, or because you loaded it (with Open) from a library 
or other data disk, you are not prompted for a new name. The cur­
rent name is used and the save is pertormed immediately. This kts 
you quickly save an updated version of your drawing. 

Warning: Any previous version of your design with the same name 
will automatically be replaced with your current design when you use 
Save. It's assumed that you intentionally want to update the previous 
version on your data disk. To protect a pre\'ious version, use Save 
As (see below) to give your current interior design a different name, 
especially when you want to save a different view of your design as 
a separate file. You can use ".T", ".N", ".S", etc., at the end of your 
name for different views of your design (for top, north, south, east, 
west). 

Use Save frequently while you are creating a design so you'll always 
have a recent backup of it stored safely on disk. To do a fast save, 
hold down the apple key and press the letter S. Be sure to leave your 
work disk in the drive so Interiors can save your design successfully. 
If you remove your current work disk and insert a different disk and 
select Save, you'll get a volume not found error since a complete 
path name for saving ProDOS files includes the disk (volume) name. 
You need to use Save As to save to a different disk. 

Frequent saves provide added protection in case a power failure oc­
curs or your computer quits working for any reason. If you update 
your disk version often, you'll lose only a few recent changes and not 
your entire design or hours of work. 

Save As 
Use Save As to save your interior design under a different name, or 
to save it to a different disk or directory folder. You'll want to use 
Save As to give different side views of your design their own unique 
names and save them as separate files if you have customized them, 
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or used the finishing tools on them. For example. you might use Liv­
ing.S for a wom's south view and Living.N for il~ north view. Ii \'ou 
don't need any special customizing of side views, save only the top 
view of your design. The top view is the master view ,md is aJwa\'s 
saved with any other view. This means you'll usc less disk space if 
you save only the top view and use it to generate the side views the 
next time you Open the design. 

After the save, the name ahove the documc'nt window is changed to 
your design's new name. Any future saves WIth Save (ahove) arc per­
formed using the new name. 

You can usc Save As to save a copy of impmiant interior de:;igns 
on more than one disk for added protection in case one disk is in­
advertently damaged. 

Revert 
This reloads the last version (It your design that was saved to dISk. 
You can lise Revert if you've made changes since last saving your 
design and decide you don't want them. This choice remains dim and 
unselectable until you make changes to an interior design after us­
ing Open or Save. 

Scan 
Scan lets vou look at the interior dL'signs in a lhsk'~ dindon·. Select 
Scan, the~ open ,my design 111 the spc'cific dired( If'\' vou want t(l scan 
hy double-clicking on the design's name, or click on its name and 
on the Open button. When you open a file, it lets Interiors know 
which "directory" you want to scan. 

All the interior designs in the directory are shown sequentially. The 
first design you see may not he the one you opened. hut it will ap­
pear before Lhe scan is finished. 

A design is shown with the view that was current when the design 
was saved. The name of the currently scanned design is shown at the 
bottom of the screen. When yuu are ready to continue, click Previous 
to see the design you saw prior to the current design, or Next for 
the design following the current one, or click Quit to stop scanning. 
You can also press the esc key to quit. If you go heyond the start 
or end of the directory, scanning continues from the opposite end. 

Save Paint File 
To save your interior design as a standard unpacked Apple IICS paint 
file (file type $C1) that can he loaded by most popular paint programs, 
choose Save Paint File. 

You cannot reload designs that are san;d ,L'i paint files so if you want 
to use your interior design again later with Interiors. be sure to also 



save it the normal way with Save or Save As. Paint programs usc 
hit-mapped pictures, not (lhjccl~ you can select. move, and change 
as with interiors. 

Delete 
Use this to delete files that you don't want on a disk. To delete a file. 
click on its name. then click on Open. If the name is correct. click 
Ok to perform the delete, or click Cancel to relist the Illes for another 
selection. 

After deleting a file. you can continue deleting more files. or click 
Cancel. rather than on a fik's name. to quit. 

Note: Delete lets you delete only files. If you open a folder. it's opened 
so you can see the files within it. A folder cannot he delekd using 
Interiors. To delete a folder. quit interiors and use the Finder. If a 
folder is empty. no files arc listed. Click Close to exit the folder. 

Choose Printer 
Before printing. you should select Choose Printer to let Interiors 
know what kind of printer you have and what port it's connected to. 

You need to use Choose Printer only once each editing session. and 
then only if you want to print a hard copy of your interior design. 

Important: You may also need to go to the Control Panel and let 
your computer know what port is used. See "Appendix R" for help 
setting up the Control Panel for printing. 

After selecting Choose Printer. you'll see this dialog: 

Choose Printer 
Printer Type: 
lRSERWR ITER ID-
I!I' 

EPSOM 
~ I MRSEWR.IIW 

Printer Port: 
" D-
MODEM 

~ SRRPHICRRD 

OAppleTalk @ Direct Connect 

User M_e: I John Washington I 
( Cancel) ( OK ) 

AppleTalk. Sekct this as your printer port if you are using a 
LaserWriter. 

Direct Connect. Choose this option if your printer is connected direct­
ly to your computer. 

User Name. Type your user name if you are using :\ppleTalk. 

Select AppleTalk or Direct Connect as indicated aho\'e. then click 
on the name of the printer and port you are using. Click Ok to keep 
the new settings or click Cancel to retain your original settings. 

Page Setup 
Use Page Setup to set the paper size and way you want your design 
printed. This is optional. Standard settings are used if you don't change 
them. 

The ImageWritcr Page Setup dialog looks like this: 

lMAGEWRITERlPRIMTER 
Papfr: @ US letter 

OUS legal 
o All letter 
o International Fanfold 

Vertical Sizing: 
o Martial 
@Condensed 

Orientation: 

Printer Effects: 
050\ Reduction 
o No Gaps Between 

Pages 

US Letter. This is the default paper setting. It's for paper that's ~W~ 
hy 11 inches. 

US Legal. Use this option for paper that's 8 1h hy 14 inches. 

A4 Letter. This option is for European standard paper. Its size is 
8 1A by IFh inches (210 hy 297 mm). 

International Fanfold. This option is for the ImageWriter only. It's 
the International standard size of 8 1/4 by 12 inches (210 mm hy 12 
inches). 

85 Letter. This option is for the LaserWriter only (see the next dialog 
illustration). Its paper size is 15 by 11 inches (250 by 176 mml. 



Normal. This settin~ prints designs with the same proportions they 
have on the screen. 

Intermediate. Lse this to print designs approximately two thirds their 
normal size (for the Laser\Vriter only). 

Condensed. Designs printed with this option are ahout half their nor­
mal height. This option causes a design's width/height ratios to distort, 
so don't use this option unless you have a special need for that effect. 

50% Reduction. Designs are printed at half their normal width :md 
height. 

No Gaps Between Pages. Plinting is continuous without page hreaks 
when this option is selected. 

Portrait. Designs are printed with the same upright orientation the\' 
have on the screen. . 

Landscape. Select this option to print sideways (turned right gO 
de~rees). 

Here is the L~L-;erWriter dialog followed hy options that differ from 
the above descriptions: 

loser\rlriter 
Paper: @US letter 0 A4letter 

o US legal 085lettfr 
Orientation: Yertica I Sizing: 

o H011l01 

o Intefllediate 
@Condensed 

Printfr Effects: R d 
e uce or I rnrnl 181 Siloothing? En large: \ 

181 Font Substitution? 

~CDli 

Printer Effects. These LaserWriter options are for bit mapped fonl., 
and are ignored. 

Reduce or Enlarge. You can type a number from 25 to 200 to reduce 
or enlarge your printout. A value of 100 is normal size (100% of im­
age), 200 enlarges a desi~n to twice its size (lOOIVrJ X 2 = 200%), 
and 50 reduces a design to half its normal size (1001),1) 12 = SOIVl)). 

\ 
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Print 
Select Print to set the number of copies you want. whether to print 
in color, and to print an interior design. 

Warning: hefore you print. he sure to use Choose Printer (ahllve) 
or your computer may hang up, forcing you to rehoot the computer. 

This is the dialog you'll see for the Image\\'riter: 

IHRSEWRIT£RlPRIMT£R 
Qualit,,: o Better Tut 

@Better Color 
ODraft 

Page range: 
@All 

o Froa: D To: D 
Capies:[[] 
Paper f eed:@ Autoaatic 0 Hanua 1 

OColor 

Better Text. This option doubles the printer resolution. It produces 
the hest ljuality text and lines. However. fewer colors :Ire available. 
Use this option when the quality of lines, hlack zll1d white patterns, 
~lf1d text is more important than a wider range of colors. 

Better Color. y\ore colors and hetter shades of gray are produced 
with this option, but the printer resolution is lower than with Better 
Text so lines are more coarse and text may not be as readable. 

Draft. Don't lise this option. It's llsed for dumpin~ text straight to 
the printer and isn't used for graphic drawings. 

Page Range. This option is ignored. An entire design is always 
printed. 

Copies. Type the number of copies you want to print. The computer 
automatically moves the printer's paper to the next page and prints 
each copy (if Paper Feed is set to Automatic-see below). 

Automatic. l:sed for continuous paper. The computer advann:s the 
printer's paper and continues to print if you are printing multiple 
copies. 
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Manual. Ii printing multiple copies. you are prompted bdore each 
copy. and can continue to print or stop. 

Color. Ii YOU have an ImageWriter II and a color ribbon. you can 
select thi; option to print designs in color. An ImageWriter I can't 
print in color. so you shouldn't use this option with an Image\Vriter I. 

Here is the print dialog you'lI see ior the LaserWriter. 

lRSERWRITERlRPPlETRlK 
Pages: @RII 

OFra.:D To: D 
Copies:[[] 
Paper Source: 

@PaperTrall 
o Manual Fet!d 

(Cancel) CE) 

Pages. As with Page Range for the Image Writer. this option is not 
used. 

Copies. Type the number of copies you want to print. If you need 
to. use the tab key to move to the copies' box to type a number (or 
click on the box). 

Paper Tray. You can use this option if you have a paper tray. 

Manual Feed. Use this option for feeding single sheets of paper by 
hand. 

To Start Printing. Once you have all the Print options set as desired. 
dick Ok to start printing. Remember to make sure your pnnter IS 

on and ready for printing. 

You can press the apple and period keys to stop printing in pro­
gress. or when a drawing has completely printed. press them to save 
time and avoid waits for the printing sequence to end. 

Re sure your computer's Control Panel settings are set to the right 
slots for your printer or your computer may hang up ;vhen you try 
to print. See "Appendix B" if you need help settIng the Control Panel. 

If you decide not to print. dick Cancel. 

Quit 
When you are completely finished using Interiors: select Quit. You 
are given the chance to save recent changes betore qUIttIng. 

,\ 
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Edit Menu 
All the choices under Edit except Change Room work with furniture 
()bjecl~ or custom drawn objects that have been selected with the 
Selector Tool. Before using most of the menu items discussed here. 
you must select one or more objects. 

To select an object when using the finishing tools. click on the 
Selector Tool to activate it (it's the arrow at the top of the tool:; win­
dow). then move onto an object and click to select it. If you are not 
using the finishing tools. simply move onto a piece of furniture and 
click to select it. Press the apple key before clicking to select more 
than one object at once. 

For additional help selecting ()bjecl~. do the "Trying Out Interiors" 
section in chapter 1, and see "Selecting Objects" in chapter 2. "Draw­
ing Tools". Also note that some items under the Edit menu arc 
available only when you are using the finishing tools and are dim 
otherwise. 

Undo 
You can use Undo to reverse the last change made to your design, 
or when using the finishing tools. the last change made to your color 
palette also. In most instances you can select it again and reverse 
the Undo. When using the finishing tools. this Undo works the same 
as the Undo in the color tools window. 

Cut 
Cut removes objecb from your design and places them in a clipboard 
file. You must click on objecb to select them before you choose Cut. 
The current directory of the disk you used last is used for the clip­
board file. Any object<; which were already in the clipboard file are 
replaced. 

Be sure the disk is ready and in the drive or the Cut will be unsuc­
cessful and an error will be reported. If you change your mind and 
want to restore your objecb, click Undo. 

You can select Paste to put the objects back into your current in­
terior design. or open a different design and choose Paste to put 
them into it (see "Paste"). 

Copy 
Use Copy to store a duplicate of selected objects in the clipboard 
file. Click on objects to select them before you choose Copy. The 
objecl~ you copy replace any objects already in the clipboard file. Your 
design is not changed. 



Y ()u can select Paste to put the object-; back into your current in­
terior design or another design at a later time (see below). 

Paste 
Choose Paste to copy all the objects in the clipboard file (on the disk 
you used la-;t) into your drawing. The object'i arc automatically selected 
so you can easily move the p(L'ited object'i where you want them. Click 
Undo to remove pasted objects. 

Note: You cannot put side views of furniture into top views or top 
views of furniture into side views. A message telling you this is shown 
if you try. You can put any view of furniture or any other object<; into 
your design when using the finishing tools. 

Select All 
Choose Select All or press apple and the letter A to quickly select 
every object in your drawing. You might want to do this to change 
the border color. working wlor, or line width for all objects, or to 
unlock. lock, move, or drlete all object<; at once. 

Lock 
First click on one or more objects to select them, then choose Lock 
to keep them from being moved or changed. Locked object<; cannot 
be moved, grouped, deleted. or changed in any way (except with New 
or Close for starting a new interior design). 

Objects that are locked have a small key-like symbol above their top 
left handle (after you've clicked on them to select them). The only 
editing operation that will have an effect on locked objects is Unlock. 

This feature can be quite useful. For example, you may want to lock 
some furniture so vou can arrange other furniture nearby without 
accidentally changing the furniture objects you don't want changed. 

See the note below pertaining to room walls. 

Unlock 
First, click on one or mort: locked objects to select them, then choose 
Unlock so they can again be manipulated and changed. 

Note: Room walls are automatically locked. You can unlock and 
change them after selecting Use Finishing Tools from the Options 
menu, or by choosing Change Room under the Edit menu. 

Group 
You can use this feature after you select Use Finishing Tools from 
the Options menu. 
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\, roup converts a collection of objects that you haw selected \\:ith 
I, Selector Tool into a single grouped unit. All the pre-drawn tur-
111111' objects are examples of grouped objects. You must have more 

'11111 one object selected before you can use Group. For.help selec­
, II~ objects. see "Using The Selector Tool" in the ."Tl):~ng Out In-
1 Ilors" section oi chapter 1. and also "Selecting Objects In chapter 

I Ihll'Ct~' screen coordinates and sizes are not changed by grouping 
111\'111. The grouped objects are treated as a single object until t~ey 
II \' ungrouped. This means if you select a grouped object. then chck 
, II I ~I color, all the individual objects within the group take on the color. 

\ I III can use Ungroup (below) to separate grouped obje~t~ a~d change 
I 'Ingle object within a group, then regroup them agaIn atte:wards. 
II\ls is important to remember because wh~n y~)U are USIng the 
Illlishing tools. you can ungroup pre-drawn turl1lture objects and 
, IIstomize them al1\" wav you like, or you can create your own custom 
Illrniture objects and sa~e' them to disk for use in other interior designs 
1'1'1' the "Objects" menu section for more). 

l 'ngroup 
Ihis item is available when using finishing tools. It separates grou~ed 
'.\11ects into their individual component objects. You need to chck 
'Ill :1 grouped object to select it before choosing Ungroup. See 
l;roup" above ior more. 

Change Room 
You can select Change Room to change an existing room's wall 
Il1Itline. This item differs irom creating a new room in that eXistIng 
IlIfniture is kept after you make changes to your room. 

\fter vou select Change Room, you'lI see the same dialog appear 
,IS when vou create a new room. However. the Draw Custom R?om 
hutton changes to Edit Custom Room. The options in the dlalo,g 
WI Irk the same (L'i for creating a new room. If you change the n~om s 
dimensions and click Ok, you'll get a rectangular room (even If you 
previously had a custom room) set to the specified di~e~sions. If you 
dick Edit Custom Room, the editing screen and eXlstlllg walls ap,~ 
pear so you can change them as desired. See "Creating A New Room 
111 chapter 1 for details on drawing and editing walls. 

When you've finished changing your room's outline and go back to 
t he design screen, your original furniture is redrawn. However, you 
mav need to re-position furniture depending on the changes you made 
til }'our room's walls. 

Note: If your room is a custom drawn room. and not rectangular, 



the dimensions shown in the dialog text boxes represent the outside 
boundaries of your room. 

Adjust Menu 
All the choices under Adjust work with ohjects that have been selected 
and .have visihle handles. Work through the "Trying Out Interiors" 
sectIOn of chapter I and see "Selecting Objects" in chapter ~ if \·ou 
need help selecting objects. . 

Move To Top/Bottom 
These two choices let you rearrange the stacking order of ohjecl.; 
that you've seleckd. You can select an object and place it beneath 
(or behind) another object with Move To Bottom. or mow a selected 
object in front 01' another object with Move To Top. 

When viewing your room from the side. these items are dimmed. Fur­
niture ohjects in side views are automatically placed hehind or in front 
of other furniture objects according to their depth in the room. 

Rotate Left/Right 
When viewing your room design irom the top. or when using the 
finishing tools. use these menu items to rotate ohjects that you've 
selected left or right 90 degrees. 

(n the case oi side views. furniture is rotated left or right to iL~ adja­
cent side view. For example. ii you Me looking at the iront oi a chair 
and rotate it right. you'll he looking at the right side oi the chair after 
the rotate. 

Note: The command key for selecting the Rotate Right menu item 
from the keyboard is the vertical bar on the right side oi the space 
bar and NOT the letter I. which it might be mistaken ior when pull­
ing the Adjust menu down. This means you can hold the apple key 
down and press the vertical bar to select the Rotate Right item. The 
rotate command keys are logically placed on the leit and right side 
oi the space bar. 

Flip HorizontallV ertical 
When viewing your room design from the top. or when using the 
finishing tools. you can use these items to !lip the orientation of 
selected objects from left to right (horizontally) or top to hottom 
(vertically). 

In the case of side views, Flip Vertical is dimmed and Flip Horizontal 
changes to Flip Opposite. which !lips a furniture object to its op­
posite view. For example. if you were looking at the front oi a chair 
and selected Flip Opposite. the front view of the chair would change 
to a hack view. 

Text Menu 
Items under the text menu let vou choose the kind and size of text 
\'Ou want to use. or let you rean:ange text within your interior design. 
However. Text menu items are finishing tool features and are dim 
until you select Use Finishing Tools under the Options menu. 

Choose Font 
he Choose Font to pick the font you want for typing text with the 
Text Tool. You can also set the font's size ami style. 

The changes you make are used the next time you type using the 
Text Tool. If the Selector Tool is acti\'e and you'vc selected one 
or more text objects. settings made with Choose Font also affect the 
selected text objecl~. This lel~ you change the size. style. or font of 
existing text. 

Mter you select Choose Font. the following dialog appears: 

Font: 
Courier St Geneva 
He I vetica 

-"'1~"', 

Times ro-Venice 

StHle: Size: Other 
t8]Plain 

OJ 
Size: 

DBoid []CJ 
o Italic 

(Cancel) o Underline o Outline « ) o Shadow OK 

Font. When Interiors begins. the font for the Text Tool is defaulted 
to the S\'s1em font. The default S\'stem font is called Shaston. 
r<ememher il<; name in case you wa~t to use it again after you ha\'e 
changed fonts. Its default size is 8. and its default style is Plain. 

To choose a font. click on its name. The chosen font is highlighted 
(darkened). If you need to. use the scroll bar arrows to scroll the list 
of font names. 

Note: The fonts vou can choose from arc in the !SYSTEM!FONTS! 
folder of the disk that you started your computer with. These names 
are listed in the Choose Font dialog. 



Style. A font's style refers to the way a font looks. Style choices in­
clude Plain. Bold. Italic. Underline. Outline. and Shadow. Here's 
how they look: 

Plain 
Bold 
Italic 
Underline 

ffimGilfim@ 
0lll(!]c!1(!J]J 

You can use all the styles at once except Plain. which cancels all 
other styles (iI's plain). Also. Underline is not supported for the system 
font. Shaston. 

To select a style. click the hox next to its name. A second click 
unselecL~ it. 

Size. To select or change the size of a font. click on a numher in 
the Size catalog (the larger the number. the higger the text). or type 
a numher in the Other Size box. The fonts look best at the cata­
lo~eJ sizes. hut you can specify other sizes. The nearest matching 
font is scaled to the size you want. 

When all the settings are what you want. be sure your start-up disk. 
normally the InteriOJ:-; program disk. is in the drive so the Font 
!\1ana~er can load the font you have chosen from the 
ISYSTEM/FONTI folder. then click Ok to install the new font and 
use any size or style changes that you have made. If the Font Manager 
cannot load the chosen font. it will default to the nearest matching 
font it can find. Click Cancel to discard any changes and keep the 
ori~inal font. size. and style. 

Arrange 
This menu item works with objecl" that have been typed using the 
Text Tool and have been selected with the Selector Tool. It's dimmed 
if no text objects are selected. 

If you need help selecting objects. work through the "Trying Out In­
teriors" section in chapter 1 and see "Selecting Objects" in chapter 
2. See the "Text Tool" section of chapter 2 for how to type and create 
text objects. 

After selecting Arrange. the following dialo~ appears: 

Arrange Text 

Horzontal 

« 

DAs Is 
DLeft 
181 Center 
D Right 

Ok lJ 

Vertical 

181 As Is 
DTop 
D Center 
D Bottom 

( Cancel) 

Options in the dialog window an: selected when an X arrears in the 
hox beside them. Click on the hox to select an option. 

Horizontal Options. Use these options to arrange selected text 
horizontally (left-right) on your interior design page. not just within 
the document window. You can use Sec Full View under the Op­
tions menu to examine the resull'i. 

llse As Is to keep your text where it is horizontally or select Left. 
Center. or Right to position text at the left edge. in the center. or 
at the right edge of your drawing. respectiwly. 

Vertical Options. These arrange text vertically (top - bottom) on 
your drawing page. Here again. you can use As Is ior no change. 
or select Top. Center. and Bottom to position the text as desired. 

Objects Menu 
Just as the name of this menu implies. items under it let you choose 
pre-drawn furniture ohjects. When you select these items. a dialog 
appears so you can see and choose a specific furniture object (ex­
cept for some items related to custom ohjects-they an explained 
later). Your choices will include only top views of furniture when you 
are working with the top view of your room, side views of furniture 
when you are working with a side view of your room. and all views 
when using the finishing tools. 

A box encloses the furniture ohject that will he chosen if you click 
the mouse button. Move the mouse so the hox encloses the ohject 
you want. then click. Furniture is placed in the center of the docu­
ment window so you can ea<;ily move it to the location you want. 
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Each letter on the keyboard corresponds to more commonl\, used 
pieces of furniture. In addition. you can press option or shift and 
a letter for another 52 furniture choices. To add furniture objecb 
to your drawing. simply press the letter corresponding to the object 
you want. When possible. the first letter of an object's name is used. 
For example, C for chair or D for door. Sometimes option or shift 
(or the previous or following letter in the alphabet) gives you another 
version of the same object. For your convenience. a quick reference 
card is included with Interiors showing what furniture corresponds 
to what keys. 

Ii you are working on the top view of your room and press a key to 
add a piece of furniture to your design. you get a perpendicular orien­
tation of the furniture. You can get a diagonal orientation of the fur­
niture by pressing the caps lock key down before pressing the key(s) 
for the furniture. In the case of side views. you get the furniture's left 
side rather than il~ front when you press caps lock down. 

When a letter is pressed. the corresponding object is placed in your 
interior design as described abo\'C so you can position it. Note that 
when placing furniture into top views. the front is always facing 
downward when the furniture is first added to your design. This is 
obVIOUS with a piece of furniture like a sofa. but isn't with some fur­
niture. The China Top. for exampk. has an overhang at the top. so 
when viewed from the top. the back looks identical to the iront. 
Howewr. when viewed from the side. the front has drawers. You'll 
need to set the back/front orientation correctlv so the furniture will 
COlwert to side \'iews properly. You can use th~ flip and rotate ilL'ms 
from the Edit menu to change furniture orientation. and it's easy 
enough to go hack to your top view and change the orientation when 
you find it is incorrect on a side view. or if you preier. you can also 
change the orientation on side views. 

Other menu items let you create and save your own custom ohject-; 
ior later use. The remaining choices in the Objects menu let you 
choose custom objects. save new ones. clear (delete) them. or load 
and save them to disk. Each of these are described below. 

Custom 
The remaining items in this section that work with custom objecl~ 
are finishing tools features. You em use them aiter vou select Use 
Finishing Tools frum the Options menu. . 

Custom lel~ you pick a custom object and add it to your interior 
design. However. before you can pick a custom object. you must create 
some or load them from disk. See "Save To" below for how to create 
your own custom objects. You can use the Load From Disk menu 
item to load existing custom objects from disk (see below also). Your 
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I~rogram disk has some sample custom objecl~ that you can load and 
experiment with. 

( )nce you have created or loaded some custom objects. select Custom 
to use them. The way you choose which custom object you want to 
lIse is the same as the way you choose a prl'-drawn iurniture object. 
\\'hen the objecl~ you can pick from arc drawn, use the mouse to 
move the selection hox and enclose the one you want. then click. 
The chosen ohject appears in the center of the document window. 
It is automatically selected so you can easily move it where you want 
it (see ":--1oving Objecb" in chapter 2 for help mm·ingl. 

You can also select up to 26 custom ()bjecl~ from the keyhoard. To 
do so. press the control key and a letter. The letter A selects the 
first custom object. the letter B the second. and so on. You can create 
\'Our own command cards. or lists. of which keys correspond to what 
ohjects, You may select up to 26 custom ohjecb in anyone custom 
object file. but you can have any numher of custom ohject files and 
load them irom disk as needed. or you can select additilmal objects 
hy choosing Custom under the Options menu when there arc more 
than 26 objects. 

After you choose Custom. if more objecl" are a\'ailablc than will fit 
in the dialog window at one time. a More button is shown. Click on 
it until you have seen all the ohjecl~ or the one you want. When the 
last object is shown. they are shown again heginning with the first one. 

Save To 
You can create your own custom objects and usc Save To to save 
them to memory. Once saved. select Custom (above) to use them 
in your drawing as needed. If you want to keep your custom ohjecL~ 
permanently. be sure to use Sal'e To Disk below before you quit 
Interiors. You are given the chance to save new or changed custom 
ohjects after you select Quit from the File menu. You can load custom 
objecl~ saved to disk and use them again later or in other drawings 
with Load From Disk. 

Save To lcl~ you sa\'e only grouped objecl" as custom objecl~. To 
create and sa\'e a custom object. you must first draw it. After select­
ing Use Finishing Tools under the Options menu. you can use any 
of the drawing tools to draw a custom object. or you might modify 
an existing furniture object and save it as a custom object. 

Once your custom object is drawn. click on the Selector Tool. ~ow 
select all the indi\'idual ohjects that make up your custom object so 
you can group them into one object. Either press the apple key and 
click on each object until they are all selected. or move the pointer 
outside the objects. press and hold the mouse button. drag the dot­
ted box around all of the objecl~. then release the button to select 
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them all. Onc: selected, choose Group from the Edit menu to group 
them Into a Single ohJcct. ;\()w you can choose Save To and sa\'e 
your grouped ohJect as a custom object. 

You can use this feature to create your own lihraries oj custom oh­
Ject.;; that you can load and use in your interior designs as needed, 

Clear Some 
You can delete one or more unwanted custom ohjcct<;, To do so, select 
Clear Some, 

Choosc object.;; y<?U want to delete the same way you choose them 
to use In your deSign, Use the mouse to mo\'c the selection hox and 
enclose the object you want to clear, then click. Do the same to clear 
more objects or click Cancel when done. 

Warning: Use care clearing custom ohjecb. You cannot recovC\' an 
objcct once it has been cleared! 

Clear All 
Choose Clear All to delete all cllstom ohiecb. You are gi\'en a chance 
to change your mind bcjore the clear takes place. Be sure that \'Oll 
n,o longer want any of the custom ohject<; hefon: you do the c1~ar. 
\ ou cannot recover the cleared custom objects! 

Load From Disk 
Use Load From Disk to load custom ohject.-; from disk. You can load 
thL' sample custom ohject.;; supplied on your program disk for ex­
perimentation, or load objccb you created and sa\'cd with the Save 
To Disk item dcscribed helow. 

Before the load occurs, you are gi\'en the option of c1caring any cx­
isting custom ohject" or adding the objccb you're going to lo<;d to 
them. This let" you mergc custom ohject files together or load more 
than one group of objecb at a time. 

Once the object" are loaded, you can select Custom (sce aho\'c) to 
use them. 

Save To Disk 
To permanently keep custom objects you'\'(' created, use this menu 
choice. The standard disk dialog will appear and let vou name a file 
for your objects. . 

You can create as many files of custom object" as vou want and save 
them for later use in your drawings. . 

Before quitting Interiors, be sure to use Save To Disk to sa\'e custom 
objects you want to keep. Any objects that are not saved to disk are 
lost when you select Quit or turn off your computer. 

Options Menu 
See Full View 
Select See Full View when vou want to see your whole intelior design 
;tJlproximately as it will app~ar when printed on paper. hut thc quality 
()f a printout will be better than what you see on the view screen, and 
the text will be more readable also. Click the mouse or press any key 
to end the view. 

Use Finishing Tools 
This item let~ you access drawing tools and colors tools for customizing 
and adding finishing touches to your interior design. Y ()u can use 
the finishing tools on any \'iew of your design (i.e. top or side viewsl. 

To use the finishing tools, click on the view icons and vic\\' your room 
from the desired view, then selcct Use Finishing Tools. Thc screen 
changes and new windows with drawing tools and color tools appear. 
An illustration of the finishing tools screen is shown in the "Trying 
Out Interiors" section of chapter 1. 

Changes you make to your design with the finishing tools cannot he 
transferred to other views. However, you can save your finished design 
to disk and Open it again later. then make additional changes to it 
if you want. or change hack to any of the other views as they originally 
wcre hefore you made finishing changes. Side views are created from 
~'our original top view. 

You can work through the "Trying Out Interiors" section ior some 
hands-on experience with the finishing tools. You'll find completl' 
details on all the drawing tools, color tools, and on creating custom 
object<; in other chapters of this user's guide. See "Drawing Tools" 
in chapter 2 for a description of the drawing tools and help using 
them. Read chapter 3, "Color Tools". for help with those. Consult 
other sections of this chapter, "Menus", for information on creating 
custom objecl~, using text. and editing patterns. 

ShowlHide Rulers 
Choose Show Rulers if you want visible rulers. When rulers are visi­
ble, this item changes to Hide Rulers so you can remove them. 

Numbers on the rulers represent real-world distances in the scale you 
are using (see "Scale"). 

ShowlHide Measurements 
This is a finishing tools feature. It is enahled after you select Use 
Finishing Tools, 
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!i you draw heyond the hottom or right side of the window. your draw­
mg IS automatically scrolled. This lets you more ea<;ily dr~w object" 
that are larger than the window viewing area. 

Ii )'ou d(!n't want to use Auto Scroll. select this item to disahle it. 
~\ hen disabled. you can usc the scroll bars to scroll your drawing 
If you need to. ~hck on the scroll bar arrows for small moves. in the 
page area (.heslde the box) for larger moves. or drag the scroll bar 
hox to pOSitIOn your drawing ali desired. 

Patterns 
If you are using the finishing tools. you can choose Pattern to change 
~xlstmg patterns or to load patterns from disk. After selecting this 
Item. this dialog appears: ' 

Click on Square to Edit 

Working Color 

Working Pattern 
(Click for next 

page of patterns) 

, 

• , . 
•• •• •• 

•• •• •• 
,.... 

¢ Ok 
(L Save 

/ 
Save Pattern to Disk 

• 
•• • • • •• 

;,;. I. I..,... "1 
'~"y;Vllllll I ""t:Sr'tr"l 

~ r Cancel +-
] ( Load 1 

\ 

Click for 
Active Color 

Click to Discard 
Changes & 
QUit Editing 

Load Pattern from Disk 

To edit a ~attern. click on the pattern you want to change to make 
It the workmg pattern. then click on the color you want to use. Move 
the pointer o~to the pattern square that you want to change and click 
(m the large. tat pixel hox on the left). You can hold the button down 
an9 move the mouse ior continuous drawing. Squares under the 
pomter change to the working color. The reference area in the large 
box on the right is updated for a true size perspective of your changes. 

You can get the next page of patterns by clicking on the working 
pattern square that's next to the line of patterns in the palette. 

To copy patterns. move onto the pattern you want to copy. then press 
and hold down the mouse button. Move the pattern's outline to the 
new location and release the button. You can drag the outline off 
the left or right end to copy to the next page of patterns. 

Click Save to save a permanent copy of your patterns to disk. or click 
Load to load patterns that you have previously saved. 
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If you click Cancel. all chJ.nges made to the patterns are discarded. 
the pattern dialog disappears. ~md your original patterns arc restored. 

If :I'OU click Ok. all changes to the patterns are kept. the pattern dialog 
disappears. and your working patterns on the paldte are redrawn 
using the newly-changed patterns. Until you make other changes. you 
can still click Undo to restore your original patterns. 

Default Patterns 
\Vhen using the finishing tools. this menu item initializes the palette 
patterns to the default patterns. the same patterns that existed when 
Interiors first began. Select Cndo to reverse this selection. 

Default Colors 
When you are using the finishing tools. Default Colors initializes 
the palette colors to the colors they were when lntaiurs st,n1ed. Click 
Undo to reverse this selection . 

Memory 
This item is pro\'ided so you can monitor your memory usage. The 
amount of free memory available for usc. the largest continuous hlock 
of free memory. and the amount of memory currently used hy your 
interior design drawing are shown. 

\\'hen the in:c memory gel" below approximately 401\ or the largest 
hlock geb below approximately 251\. be sure to save a current copy 
(If your drawing to disk. If either of these values go much lower than 
this. you']] see a dialog warning you that your memory is getting 
dangerously low. 

Save your drawing to disk. and it's best to sa\'C a backup copy on 
a different disk also. Then if you can. in~e up more memory by reducing 
\'Our RAM disk size if you arc using a RAM disk. Rememher to turn 
your computer off and restart so the new HAM disk settings will take 
effect. 
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Appendix A 
Error Messages 
No clipboard file 
This error indicates there isn't an Interiors c1iphoard file on the last 
disk that you used. It may occur if you try to Paste before \'OU have 
used Cut or Copy. [se Cut or Copy to create a cliphoard file and 
place (cut or copy) object, into it. then don 't chan~e disks before vou 
use Paste. If you need to switch disks, do it before you perform 'the 
i_nitial. Cut or Copy since the workin~ disk is used for the cliphoard 
1I1~'. \ ou can. make another disk the working disk hy cataloging it 
(WIth Open tor examplel. then clicking cancel. 

Object file I/O 
You'll see this only when Interiors first start" if no pre-drawn ohiecb 
can he loaded. You can click Ok and still have limited use of InteriO/:~ 
(you can't usc pre-drawn obiect, or change views hut the finishing 
tools arc available). To avoid this error, if you've copied Interiors to 
a different volume or Hard Disk. he sure the INTERIORS.DAT A 
folder resides in the same folder as the Intl'l'iors application and that 
it contains a good cop)' oj the INTERIORS.OBJS file. 

Pattern file I/O 
Y (lU 'II sec this only when interiol:'; first start, if no patterns can he 
loaded. You can click Ok and still have limited usc of Interiors (the 
default patterns for the pre-drawn ohject, will not he available). To 
avoid this crror, if yOU'\'L' copied Interiors to a different volume or 
Hard Disk, he sure the INTERIORS.DAT A folder resides in the same 
folder as the Interim:, application and that it contains a good copv 
of the INTERIORS. PATS file. . 

A 1 MB + system is needed 
This is shown at start-up if your computer doesn't have enough free 
memory for Interiors to start. 

ProDOS (GSOS) I/O 
The operating system was unahle to read or write data to disk. The 
reason may vary. The disk may he physically damaged or have had 
data on it compromised in some way. 

Write protect 
A disk is write protected and cannot be written to. Remove it from 
the drivc and disable the write protect tab. See Chapter 1 for how. 
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Volume or Path not found 
This might occur if you switch disks or remo\'(~ a disk from the drive 
and trv to do a Save, Cut. or Copy. Sec the ":--';0 clipboard tile" sec­
tion above and "Save" in the "l\lenus" chapkr for related informa­
tion. Use Save As to save to a different disk. 

Volume full 
There isn't all\' more room on the disk. You'll need to save to a dii­
ferent disk O\--initialize (with the Finder) another data disk to usc. 
See the "Getting Started" section in Chapter 1 for help making data 
disks. 

Invalid directory 
The directon' or suhdirecton' on the disk has prohahly heen com­
promised. Y~)u'lIlikely need to use the Finder and Copy all the tiles 
you can to another disk. then initialize the bad disk again. 

Out of memory 
You don't have enough free memory to do \\'hakver it is you arc try­
ing to do. Ii you are using a RAM disk. you may be able to set it to 
zero or reduce it, size to free more memory. 



Appendix B 
Setting The Control Panel For Printing 
This sl?ction helps you set the Control Panel for printing. If you have 
already started Interiors, you'll need to save any existing design since 
y.ou'll ha\'e to restart your computer after working through this sec­
t)(>o. Please consult your Apple IIGS Owner's Guide for more infor­
mation about the Control Panel. 

1. If your computer is on, press the apple, control, and esc ke\'s 
simultaneously to access the Desk Accessories menu. If vour com­
puter isn't on, hold down the option key and turn it o~. then at 
the resulting menu, press 1 and go to step 3. 

2. Fse the up or down arrow key to highlight the Control Panel item 
and press return. 

3. llse the up or down an'ow key to highlight the Slots item and press 
return. 

4. ;\ow, usc the arrows to highlight Slot 1 if your printer cahle is 
plugged into the printer port at the back of your computer, or Slot 
2 if it is plugged into the modem port. 

5. ese thl? right arrow key to change the highlighted slot as follows. 
Set Slot 1 tu Printer Port if your printer is connected to the printer 
port. Set Slot 2 to Modem Port if your printer is connected to 
the modem port. Set the highlighted slot to Your card and Slot 
7 to Built-in AppleTalk if you are using a LaserWritcr or an Ap­
pkTalk network (a LaserWriter uses an AppleTalk network setup}. 

6. Press return to keer thl? new settings, highlight Quit and press 
return again to exit. 

7. Turn your computer off and wait ahout :10 seconds hefore turn­
ing it back on. You need to turn your compukr off to initialize 
the system with the nl?w Control Panel settings. Refer to the "Get­
ting Started" section for help in restarting.' 
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;\ppendix C 
..... l'tting Your RAM Disk To Zero 

',lIlIfS requires a minimum of 102-1K (1~IB) of iree memm\' to 
1·I.lk. so to ensure enough memory is iree, set your RA~1 disk ~ize 
, " '10. The following steps show you how. 

II \'Our computer is on, press the apple, control, and esc kevs 
," thl? same time to access the Desk Accessories menu. [i \'our CO~l­
l'lIkr is off, hold down the option key and turn it on: 

It V( IU hegan with your computer off. press 1 to select Control 
Panel. [f your computer was on, then at the Desk Accessories menu, 
ll';c the arrow keys to highlight Control Panel and press return. 

Is~' the up and down arrow keys to highlight RAM Disk and press 
return. 

I I' Sc the right and left arrow keys to set hoth the minimum and 
1I1;lximum RA:'v1 disk sizes to zero and press return. 

I'mn off your computer so the new settings will take efied. 1'\()\\' 

II III can start Interiors as descrihed at the heginning oi this user's 
.'.lIide. 
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Appendix D 
Installing Interiors On A Hard Disk 
1. Use the Finder to copy the Interiors application file to the desired 

Hard Disk folder. You can use an existing folder or create a new 
folder. 

2. Copy the entire Interiors.Data folder that resides on the program 
disk (not the data disk) to the same folder on the hard disk that 
contains the application file. 

3. Copy the Interiors.Icons file inside the Icons folder of the original 
Interiors program disk to the Icons folder of the boot volume on 
the Hard Disk so the Finder will use the Interiors program and 
document icons if you boot from the Hard Disk. 

Ii:! 

l\ppendix E 
Side Views of Sample Rooms 

Living Room 1 

Living Room 2 

Large Living Room 1 



Bedroom 

Large Bedroom 1 

Large Bedroom 2 
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+ + + + + + + 

++++++ 

Bathroom 1 

Bathroom 2 

CJ OD~ 
Kitchen 1 



Kitchen 2 
Dining Room 1 

Large Kitchen 1 
Dining Room 2 

Dining Room 3 
Large Kitchen 2 

tii 
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h 
Work Area 2 

Work Area 3 

Work Area 4 
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Appendix F 
Extra Copies of Command Cards 

KITCHEN GS Inferiors 
DIMENSION 

OBJECT KEY Depth Width Height 

(Distance from floor) 

Cabinet Drawers K 24 18 36 

Cabinet (high) Opt-K 14 18 30 
(4'6") 

Cabinet (low) Shf-K 24 18 36 

Counter End Opt-J 24 12 36 

Dishwasher Opt-D 24 24 36 

Freezer Opt-F 28 48 32 

Microwave/TV Cart N 20 26 32 

Microwave/TV Opt-N 20 26 16 
(2'8", sits on cart) 

Refrigerator Opt-R 28 24 60 

Sink (dbl) J 24 48 36 

Range Shf-R 24 36 36 

Table Opt-G 48 48 30 

CAPS LOCK DOWN: Diagonal of object on top view 
: Left side on side views 

TOP 
VIEW 

~ 

'--' 

0 

-
-

=' 

-
~ 

,--r 
L-..J 

r-
'-

C 

n 
<==' 

-
~ 

LITJ 

I~I 

~ 
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LIVING ROOM GS Interiors 
DIMENSION 

TOP OBJECT KEY Depth Width Height 
(Distance from floor) VIEW 

Armchair A 28 28 30 0 

Coffee Table Shf-E 20 48 15 c::::J 

Fireplace F 5 48 36 -

Lamp L 16 16 28 ©J 
(1'6", sits on E. table) 

Ottoman 0 26 26 18 0 

Piano Shf-A 60 56 40 D 
Recliner R 35 30 37 0 

Sofa S 32 72 36 EDJ] 

Modular Sofa Opt-S 34 22 30 rJ 

Modular Sofa End Shf-S 34 28 30 (j 

Wood Stove Shf-Q 28 20 28 bl 

End Table 1 E 32 22 26 0 
End Table 2 Opt-E 32 22 18 El 
Game Table G 32 32 28 0 
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DINING ROOM GS Interiors 
DIMENSION 

( ) BJECT KEY Depth Width Height 
(Distance from floor) 

1\ uffet Opt-H 17 44 32 

abinet (high) Shf-I 14 32 30 
(5') 

hina Top Shf-H 17 44 40 
(2'6", Sits on Buffet) 

c upboard Shf-J 18 40 68 

I 9 ht (hanging) Shf-L 24 24 24 
(5'7") 

able 1 T 40 56 28 

fable 2 (round) OpH 48 48 28 

I.lble 3 (rounded) Shf-T 40 56 28 

I APS LOCK DOWN: Diagonal of object on top view 
: Left side on side views 

TOP 
VIEW 

--

CJ 

--

c:::= 

'Xl 
~ 
oX 

-
'i : , , 

,,, 
' ' 
~ 

0 



BEDROOM GS Interiors 
DIMENSION 

OBJECT KEY Depth Width Height 
(Distance trom floor) 

Bed (double) B 60 80 40 

Bed (single) Opt-B 36 80 30 

Beds (bunk) Shf-B 39 80 68 

Dresser (double) Opt-U 20 52 33 

Dresser (single) U 20 32 38 

Table (bedside) Shf-U 18 20 28 

Vanity Opt-V 18 52 28 

Vanity (w/mirror) V 21 52 42 

CAPS LOCK DOWN: Diagonal of object on top view 
: Left side on side views 
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TOP 
VIEW 

[] 

D ' . 

CJ 

. ' 

-

0 

ITIJ 

ITIJ 

BATHROOM 
)BJECT 

lathtub 1 

3athtub 2 

u athtub 3 

Hamper 

Mirror (lighted) 

Shower 1 

Shower 2 

'-link 1 

Sink 2 

Sink 3 

roilet 

GS Interiors 
DIMENSION TOP KEY Depth W.dtr. Height 

VIEW (Distance tram tloor) 

Y 32 60 16 ;-
L--

= 
Opt-Y 52 52 16 I 

.~ 

Shf-Y 52 52 18 :i"" 
,L-

H 16 24 30 ,.----, 
'---' 

Shf-M 5 36 36 ~ 

(2'6", sits on Sink 2) 

30 76 
.-,. 

Opt-X 30 ~ 

Shf-X 32 30 76 
, 

Z 22 34 33 [QJ 

Opt-Z 22 36 34 
-~ 

Shf-Z 33 36 36 <6 

Shf-V 24 20 28 'tr 
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OTHER GS Interiors 
DIMENSION TOP OBJECT KEY Deplh Widlh Heighl 

VIEW (Distance from floor) 

Bar, Stools Shf-G 38 48 36 0 
00 

Bookcase Opt-A 12 32 38 CJ 

Chair 1 C 22 20 33 0 

Chair 2 Opt-C 16 20 36 c::: 

Curtain X 5 19 42 ~ 

(2'8") 

Desk Shf-D 30 60 30 D 

Door D 3 36 80 -

Ceiling Lt Fixture Opt-L 12 12 9 0 
(6'6") 

Light 2 (hanging) I 16 16 24 0 
(5'5") 

Lamp (floor) Opt-I 16 16 56 0 

Mirror M 1 31 18 -
(5') 

Round Mirror Opt-M 1 20 20 -
(5') 

Picture (framed) P 1 14 18 -
(4'6") 

Picture, Mirror Opt-P 1 24 16 -
(4') 
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OTHER GS Interiors 
DIMENSION 

OBJECT KEY Deplh Width Helghl 
(Distance from floor) 

Plant (potted) Opt-O 19 16 18 
(1'6", sits on E. table) 

Plant (hanging) Shf-O 12 12 28 
(5'6") 

Shf-P 1 22 33 Poster, Mirror 
(3'6") 

Rocking Chair Shf-C 28 26 40 

Computer/TV Shf-N 20 20 20 
(2'6", sits on desk) 

Window 3 (picture) Shf-W 3 62 42 
(2'8") 

W 3 20 30 Window 1 (framed) 
: (3'6") 
I 

Window 2 (plain) Opt-W 1 25 36 
(3') 

: 

' File Cabinets Shf-F 26 14 28 
I 
I 

, Room Divider 1 Q 3 96 72 

I 

i Room Divider 2 Opt-Q 3 72 72 

I 

CAPS LOCK DOWN: Diagonal of object on top view 
: Left side on side views 

TOP 
VIEW 

0 

~ 

-

tl 

g 

-

-
-

0 

~ 
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MENU COMMAND KEYS 

o A = Select All OU = Unlock 

o B = Move to Bottom OV = Paste 

oc = Copy OW = View 

o F = Choose Font OX = Cut 

. OG = Group 02 = Undo 

OH = Ungroup 0- = Rotate Left 

OK = Close 01 = Rotate Right 

OL = Lock 0" = Flip Horizontal 

OM = Show/Hide a: = Flip Vertical 
Measurements 

ON = New 

00 = Open 

OP = Print 
OBJECT GROUPS 

00 = Ouit 
01 = Living room 

OR = Show/Hide 
Rulers 02 = Dining room 

OS = Save 03 = Bathroom 

cl T = Move to Top 04 = Kitchen 

05 = Bedroom 

06 = Other 

00 = Custom 

0+= Save to 
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()ther Products 
F'rom Abracadata 
I ' .. sign Your Own Train, the first transit system construction set 
'hat puts a model railroad inside your computer. For all Apple Irs 
I (;S too), IBM/compatibles; and for the Macintosh, MacJnooga 
( 'hoo-Choo. 

Hun Your Own Train, the "'flight simulator" for down-to-earth peo­
pk. puts you in the engineer's seat as you run trains over \avouts that 
\'ou design yourself, For all Apple II's (GS too). . 

".\·erybody's Planner, project management and flowcharting for all 
\pple II's (GS too) and IBMlcompatibles. 

"'-"erybody's Planner Reports, provides 13 extra reports for abo\'e, 
.tli Apple II's (GS too) and IBMlcompatibles. 

[)csign Your Own Home, Architecture. Interiors, Landscape desi~n, 
.tll Apple II's (GS too), Macintosh. IBM/compatibles, specialllGS \·er. 
\Ions available. 

Design Your Own Home Libraries, 4 Architecture. 2 Interiors. 1 
I.andscape Iihrary. each with 48 complete plans. 7 libraries for each 
'Imputer: Apple II. IIGS. Macintosh. IBMlcompatiblcs. 

I.andscape Regional Image Libraries, enable you to insert regional­
,pecific trees and other landscape items into your landscape plan. 
Fi\'e libraries for Apple II. IIGS. IBM. 

Welcome!, organizational handhook for any type of organization. 
'or all Apple II's (GS too). 

Electronic Drawing, 98 pre-drawn shapes make electronic 
,chematics a breeze. all Apple Irs (GS too) and 1Bl\l/compatibles. 

Graphics Supermarket, IIGS shape utility. creates and saves shapes. 
animates and (programmers!) provides source codes for the shapes: 
prints: special developer's version available with complete program 
source codes (C and assembler); IIGS. 

We also have Apple II educational programs. Apple II programming 
utilities, and games. 

Write or call us for 
more infi.Jrmation. 

*A~!u~~/~m~n~o!w~ 
PO BOX 2440 

EUGENE. OR 97402 
,503, 342 JO.lO 



LIMITED WARRANTY, 
DISCLAIMER OF W ARRANTlES, 
AND UMITATIONS OF LIABILITIES 
~ Ltd. warnnts to the hcmsoe and no oIheT penon or entity the disIa on which DESIGN YOl:R OWN HOME. 
INTERIORS on =onled !but not the sotn..,.. nor !hi> llWluaIl to be free from defects in materials and workllWl>hip 
u~ nonnaI .... for • penod 0130 days aftu the clair 01 oriainol purchas<. If duri"ll this JO.day penod • defect should 
occur. the disk may be mumed with • copy 01,.,... datrd ..... ,..,.;pc ond. bno{ doscnptJon d the problem to AInc.odaIa. 
Ltd. P.O. Box 2440. E_. OR 97402. fo< repiaamcnt free d ctwa<. Your sol< mnedy In the .~t 01. defect 
In • disk is limittd to ~.ment 01 the disk is pnMdtd ........ Any imphtd wilT.nties _Iicabl< to the disk IhiII 
!tm1inolt not Iatt, th ... 30 days iftet' the oriainol clair 01 purchas<. If the disk his betn physocally damiatd. i> beyond 
the 30 day limit. or IS not occompanied by pnool 01 purchiSt. includt S 10 PtT ach disk pillS S4 00 po~.nd handll"II 
PtT ~ PIe"", return the disk only. not the tnti .. PiCkaQe. 00 not stople or PiPt'r dIp the disk. Pack>goe the disk 
corefuIly to prtYent boondlnQ. and mark the packaee"Oo not X·Riy or U .. !oI~" Ship via l:PS or U.S. Posul 5«. 
voce with return receipt requested. Abra.:adata. Ltd. is not respon>oble for disks not rece,vtd wh<n you c.nnot provide 
pnooI 01 your shipment ond our =e,pt. 

DESICN YOCR OWN HO.'lE. U,IERIORS is sold or licenstd on.., "as is" biSis. Except ., provided abo .. with respect 
to the duks. Abracadata. lid. mak .. no other wornnl) or auarantee 01 any kind. express or implied or slatutory. WIth 
~ to DESIGN YOl:R O .... -S HOME. U,'TERIORS. it quolity. performance. iCCUlOCY. merchanlibility. or frt .... 
for Ma)' p.Arbcular PllI"jX)SC: and a.ssumes no responsibility or lWIility to the licensee or my other person or entity with 
re5Ptct to .ny cia"..., caused or iIIleg"d to be uused by use 01 DESIGN YOl:R OWN HOME. U,'TERIORS. Tho: entire 
nsk as to the quaJ,!}. suiti.b,I,ty. accuracy and performance of DESIGN YOl:R OWN HOME. INTERIORS IS with the 
lictnJee. E"<pt as prOVIded abo .. WIth respect to the disk. if DESIGN YOl'R OW/; HOME. L'I;TERIORS pro,"" defee· 
bYe ~ purch.l.«. the het""'" tond not Abracadata. Ltd .• its distributo<. its retail .. lkr or rllhen tnwolvtd in thi de ... ~'I'" 
men! 01 the product) assumes the entire cost 01 all ntCes5iry ,.,.;ana. repair. or correction. In no ewnt win Abrocodata. 
Lt<!. be habl< ior dlr<ct. ,ndlrect. IncidcntaJ or consequentiill darnaa<> resulti"ll from any detect in UESIGN YOUR 
OWN HOME. INTERIORS or from any pirticular appIiCition 01 DESIGN YOUR OWN HOME. INTERIORS b) the 
hee .... or..,y other person or eobty. """n if Abrac.adata. Ltd. his been idvistd of the pos>ibdity 01 such damag< •. 
Some sates do not a1J~ the exclusion or limitation 01 implied wammtie.s or liability (or incidental or COTUrqU.:nttaJ 
~s. so lht- above hmltatlon or exclusion may not apply to you. If any e-xdtaion or limitation shall ~ detennmcd 
by • court to be mvillid or enlorceabk. the detDmirWion IhiII not offect in any rnpe<l the validity or enforceability 
of rt'''nainina exclusiON or hmltaboru or of the SiAme exclusion M limit.Uion in dlfferent circumstances. 

AbriCadata. Ltd. iii ... II<> assurance that the information used in the development of DESIGN YOl:R OWN HOME. 
INTERIORS IS rehable ond iCcurate The recommendation.> by DESIGN YOCR OWN HOME. INTERIORS represent 
only the opm"In and JUdiment 01 the author and are intendtd to be applicable in normal circumstances. Ind,vidual 
orcumstances rna)' "'M) and mayl't'nder certaJ.n recommendations inapplicable. AL gives no M5UTance that the opin­
lOrIS a( judgment of the ..,thor are ",bable and iCcurate. 

If you have read the manual and you are having 
trouble with the program, please follow the 
procedure below to get help. 
1. Read ALL of the enclosed sheets (if any) included in the program box. 
2 Contact your dealer for further information and help with the operating system and finder. This pr0-

gram works only WIth the operating system supplied with it 
3. Did you mistakenly erase your data disk? 

If )'GU're lure you'"" doDe everythinll cnrrectJ, (or you're positive you've erased your datal. 
read the first paragraph of the Warranty statement above. 

Then. belorr you do eytlJing else. CAU us for assistance. If ..,., determine thai there is 
something wrong with your disk. we'lI give you a Return Authorization number for a return. and 
will instruct you regarding payment if you are beyond the warranty period. 

And Be Patient.. 


